Sorting in Excel

When sorting data, it's important to first decide if you want the sort to apply to the entire
worksheet or just a cell range.

e Sort sheet organizes all of the data in your worksheet by one column. Related
information across each row is kept together when the sort is applied. In the
example below, the Contact Name column (column A) has been sorted to
display the names in alphabetical order.

A A | B | C | D

1 Customer Contact List

3 | Chaturvedi, Rick 2428 S Redding St #2 B 360-555-5422  info@newhaventraders.com

4 | Dean, Hank 3034 Foggy Wharf Looj 308-555-1050  hdean@venturebrewing.com

5 | Figgis, Mallory 3520 Sleepy Hearth Dr 425-555-5370  malloryf@archerproperties.com
6 |Finn, Jake 1407 Dusty Fawn Ln 50 605-555-6435  jake@adventureoutfitters.com
7| Kinkade, Chris 1028 Quiet Dale Rd Ho1 443-555-4942 | chris.kinkade@placervilleins.com
8 |Lawson, Miranda | 5316 Colonial Pkwy Est 575-555-9255 | mlawson@massairlines.com

9 |Reyes, Felicia 8544 Lazy Bluff Ave Wh 316-555-3256  felicia@everlypublishing.com
10 | Sebastian, Lil 9060 Easy Evening Ln V 207-555-7225  lil@knopeequestrian.com

11 Silva, Vivica 8595 Thunder Brook Cil 360-555-4289  vivica@rileygardensupply.com
12 Stark, Katie 971 Cinder Butterfly St 603-555-2460  katiestark@ariarealestate.com
13 | Torrance, Jill 3160 Amber Gate Rd R¢605-555-4495  jtorrance@overlookinn.com

14 | Yuen, Phillip 5108 Crystal Gate Blvd 1 913-555-5928  yuenp@corepharmaceuticals.com

¢ Sortrange sorts the data in a range of cells, which can be helpful when working
with a sheet that contains several tables. Sorting a range will not affect other
content in the worksheet.
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3 REPS WEIGHT (lbs) REPS WEIGHT (lbs)
4 |Bench Press 14 65 12 75
5 |Bench Press { Decline ) 10 60 8 70
& |Triceps Extension 15 35 20 35
7 Average 13.9 50.5 12.5 54
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To sort a sheet:

In our example, we'll sort a T-shirt order form alphabetically by Last Name (column C).

1. Select a cellin the column you want to sort. In our example, we'll select cell C2.

A B C D E
il Homeroom #  First Name T-Shirt Size Payment Method
2 105 Christiana Chen ¢a  |Medium ‘Check Bounced
3 105 Derek FMacDonald Large Cash
" 105 Esther Yaron Small Pending
5 105 Melissa White Smaill Debit Card
6 105 Nathan Albee Medium Check
I 105 Sidney Kelly Medium Check
k] 110 Gabriel Del Toro Medium Cash
g 110 Kris Ackerman Large Maoney Order

2. Selectthe Data tab on the Ribbon, then click the A-Z command to sort Ato Z, or
the Z-A command to sort Zto A. In our example, we'll sort Ato Z.
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3. The worksheet will be sorted by the selected column. In our example, the
worksheet is now sorted by last name.

A B C D E
il Homeroom #  First Name T-Shirt Size Payment Method
2 110 Kris Ackerman Large Maoney Order
3 105 Nathan Albee Medium Check
4 220-B Samantha Bell Medium Check
5 110 Maft Benson Medium Maoney Order
6 105 Christiana Chen Medium ‘Check Bounced
i 110 Gabriel Del Toro Medium Cash
g 220-A Brigid Ellison Small Cuash
9 220-A Juan Flores X-Large _

To sort arange:

In our example, we'll select a separate table in our T-shirt order form to sort the number
of shirts that were ordered in each grade.

1. Select the cell range you want to sort. In our example, we'll select cell
range G2:H6.



F G H

Total Orders (by Grade)
Class Orders
Freshmen 5
Sophomore 7
Junior 10
Senior oo &l

2. Selectthe Data tab on the Ribbon, then click the Sort command.
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3. The Sort dialog box will appear. Choose the column you want to sort. In our
example, we want to sort the data by the number of T-shirt orders, so we'll

select Orders.
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4. Decide the sorting order (either ascending or descending). In our example, we'll

use Largest to Smallest.

5. Onceyou're satisfied with your selection, click OK.
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6. The cellrange will be sorted by the selected column. In our example, the Orders
column will be sorted from highest to lowest. Notice that the other contentin
the worksheet was not affected by the sort.

F |
Class
Junior 10
Sophomore 7
Freshmen &
Senior 5

If your data isn't sorting properly, double-check your cell values to make sure they are
entered into the worksheet correctly. Even a small typo could cause problems when
sorting a large worksheet. In the example below, we forgot to include a hyphen in cell
A18, causing our sort to be slightly inaccurate.

A B C D
I Homeroom #  First Name Last Name T-Shirt Size
16 135 Jordan Weller Large
1{ 135 Alex fuen Large
18 220A, Christopher Peyton-Gomez Small
19, 220-A Brigid Ellison Small
20 | 220-A Juan Flores *-Large
21| 220-A Chevonne Means Medium




Filtering in Excel

If your worksheet contains a lot of content, it can be difficult to find information
quickly. Filters can be used to narrow down the data in your worksheet, allowing you to
view only the information you need.

To filter data:

In our example, we'll apply a filter to an equipment log worksheet to display only the
laptops and projectors that are available for checkout.

1. Inorder for filtering to work correctly, your worksheet should include a header
row, which is used to identify the name of each column. In our example, our
worksheet is organized into different columns identified by the header cells in
row 1: ID#, Type, Equipment Detail, and so on.

A B C D E F
‘| D# Type Equipment Detail Checked Out Checked In Checked Out By
2 13000 Camera Saris Lumina Digital Camera 12-May-15 15-May-15 Shannon Nguyen
3 13005 Camera Saris Zoom Z-60 Digital Camera  27-Jul-15 06-Aug-15 Sela Shepard
4 1021 Laptop 15" EDI SmartPad L200-3 Laptop 15-Sep-15 01-Oct-15 Sofie Ragnar
5 11022 Laptop 15" EDI SmartPad L200-3 Laptop 14-Aug-15 16-Aug-15 Hank Sorenson
6 (1023 Laptop 15" EDI SmartPad L200-3 Laptop 08-Aug-15 15-Aug-15 lennifer Weiss
7 |3070 Camera Omega PixL Digital Camcorder 06-Oct-15 Min Seung
8 |1025 Laptop 15" EDI SmartPad L200-4X 26-Sep-15 04-Oct-15 Min Seung
9 1031 Laptop 17" Saris X-10 Laptop 04-Oct-15 Nick Ortiz
10 1032 Laptop 17" Saris X-10 Laptop 19-Sep-15 Stanley Geyer
11 /1033 Laptop 17" Saris X-10 Laptop 24-Sep-15 26-Sep-15 George D'Agosta

2. Selectthe Data tab, then click the Filter command.
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3. Adrop-down arrow will appear in the header cell for each column.

4. Clickthe drop-down arrow for the column you want to filter. In our example, we
will filter column B to view only certain types of equipment.

1
2 |3000 _Camera -Tvper;r:n "'_mina Digital Camel
3 3005 Camera (Showing Allom Z-60 Digital Ca
4 11021 Laptop 15" EDI SmartPad L200-3
5 1022 Llaptop 15" EDI SmartPad L200-3
6

1023 Laptop 15" EDI SmartPad L200-3




5. The Filter menu will appear.

6. Uncheck the box next to Select All to quickly deselect all data.

A B C
ID % Type Equipment Detail
. - TVPE o quip -
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sort by Color " nartPad L200-3 Laptop

partPad L200-3 Laptop
nartPad L200-3 Laptop

Text Filters A Digi
=t Eiter ' L Digital Camcorder
Search ! nartPad L200-4X
----&[Selectﬂdl] I,
T amera ji— 10 Laptop
[+ Laptop _
P { 10 Laptop
[+ Projector F‘ 10 Lﬂptﬂp
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7. Checkthe boxes next to the data you want to filter, then click OK. In this
example, we will check Laptop and Projector to view only these types of
equipment.
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8. The data will be filtered, temporarily hiding any content that doesn't match the
criteria. In our example, only laptops and projectors are visible.

A B C D E F
1 ID Type ] Equipment Detail o Checked Ouh Checked In- Checked Out By o
4 11021 Laptop 15" EDI SmartPad L200-3 Laptop 15-Sep-15 01-Oct-15 Sofie Ragnar
5 11022 Laptop 15" EDI SmartPad L200-3 Laptop 14-Aug-15 16-Aug-15 Hank Sorenson
6 1023 Laptop 15" EDI SmartPad L200-3 Laptop 08-Aug-15 15-Aug-15 lennifer Weiss
8 1025 Laptop 15" EDI SmartPad L200-4X 26-Sep-15 04-Oct-15 Min Seung
9 1031 Laptop 17" Saris X-10 Laptop 04-Oct-15 Nick Ortiz
10 |1032 Laptop 17" Saris X-10 Laptop 19-Sep-15 Stanley Geyer
11 |1033 Laptop 17" Saris X-10 Laptop 24-Sep-15 26-Sep-15 George D'Agosta
12 11034 Laptop 17" Saris X-10 Laptop 25-Aug-15 27-Aug-15 Jay Peralta
20 6100 Projector Omega VisX 1.0 28-Sep-15 01-Oct-15 Win Armitage
21 |6101 Projector Omega VisX 1.0 26-Sep-15 27-Sep-15 Michael Earley
22 |6102 Projector Omega VisX 1.0 22-Aug-15 23-Aug-15 Jamila Kyle
23 |6200 Projector Saris Lux T-80 01-Sep-15 04-Sep-15 Jolie Chaturvedi
24 16301 Projector Saris Lux T-81 Lite 10-Sep-15 Marques Herndon
25 |6302 Projector Saris Lux T-81 Lite 08-Sep-15 15-Sep-15 Dean Sorenson
31
32 |




Filtering options can also be accessed from the Sort & Filter command on
the Home tab.
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To apply multiple filters:

Filters are cumulative, which means you can apply multiple filters to help narrow
down your results. In this example, we've already filtered our worksheet to show laptops
and projectors, and we'd like to narrow it down further to only show laptops and
projectors that were checked out in August.

1. Click the drop-down arrow for the column you want to filter. In this example, we
will add a filter to column D to view information by date.

A B C D E F

ID!h Type = Equipment Detail

1

4 11021 Laptop 15" EDI SmartPad L200-3 Laptop 15-Sep-15 pan mer 15 Sofie Ragnar

5 /1022 Llaptop 15" EDI SmartPad L200-3 Laptop 14-Aug-15  (Showing All) 15 Hank Sorenson
6 1023 Laptop 15" EDI SmartPad L200-3 Laptop 08-Aug-15 15-Aug-15 lennifer Weiss

8 1025 Laptop 15" EDI SmartPad L200-4X 26-Sep-15 04-Oct-15 Min Seung

9 1031 Laptop 17" Saris X-10 Laptop 04-Oct-15 Nick Ortiz

10 |1032 Laptop 17" Saris X-10 Laptop 19-Sep-15 Stanley Geyer

11 |1033 Laptop 17" Saris X-10 Laptop 24-Sep-15 26-Sep-15 George D'Agosta
12 |1034 Laptop 17" Saris X-10 Laptop 25-Aug-15 27-Aug-15 lay Peralta

20 |6100 Projector Omega VisX 1.0 28-Sep-15 01-Oct-15 Win Armitage

21 /6101 Projector Omega VisX 1.0 26-Sep-15 27-Sep-15 Michael Earley
22 |6102 Projector Omega VisX 1.0 22-Aug-15 23-Aug-15 Jamila Kyle

23 |6200 Projector Saris Lux T-80 01-Sep-15 04-Sep-15 Jolie Chaturvedi
24 16301 Projector Saris Lux T-81 Lite 10-Sep-15 Marques Herndon
25 |6302 Projector Saris Lux T-81 Lite 08-Sep-15 15-Sep-15 Dean Sorenson
31

32

2. The Filter menu will appear.

3. Check oruncheck the boxes depending on the data you want to filter, then
click OK. In our example, we'll uncheck everything except for August.
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4. The new filter will be applied. In our example, the worksheet is now filtered to
show only laptops and projectors that were checked out in August.

A B C D E F

1 IDJh Type ] Equipment Detail o Checked Ouh Checked In- Checked Out Byn

5 /1022 Llaptop 15" EDI SmartPad L200-3 Laptop 14-Aug-15 16-Aug-15 Hank Sorenson
6 /1023 Laptop 15" EDI SmartPad L200-3 Laptop 08-Aug-15 15-Aug-15 lennifer Weiss

12: 1034 Laptop 17" Saris X-10 Laptop 25-Aug-15 27-Aug-15 lay Peralta
22: 6102 Projector Omega VisX 1.0 22-Aug-15 23-Aug-15 Jamila Kyle
31
32

To clear a filter:

After applying a filter, you may want to remove—or clear—it from your worksheet so
you'll be able to filter content in different ways.

1. Click the drop-down arrow for the filter you want to clear. In our example, we'll
clear the filter in column D.



. . N
Equipment Detail = Checked OuH Checked Inn Checked Out By =

5 11022 Laptop 15" EDI SmartPad L200-3 Laptop 14-Aug-15 1€ fower 1t Hank Sorenson

1023 Laptop 15" EDI SmartPad L200-3 Laptop 08-Aug-15  Equals "August 2015" Jennifer Weiss

12 /11034 Laptop 17" Saris X-10 Laptop 25-Aug-15 27-Aug-15 lay Peralta
23-Aug-15 Jamila Kyle

22 |p102 Projector Omega VisX 1.0 22-Aug-15

2. The Filter menu will appear.

3. Choose Clear Filter From [COLUMN NAME] from the Filter menu. In our
example, we'll select Clear Filter From "Checked Out".
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4. Thefilter will be cleared from the column. The previously hidden data will be

displayed.



Type = Equipment Detail = Checked Ou Checked In- Checked Out By =

1

4 : 1021 Laptop 15" EDI SmartPad L200-3 Laptop 15-Sep-15 _Q’:Eedﬁof:t:_lS Sofie Ragnar

5 11022 laptop 15" EDI SmartPad L200-3 Laptop 14-Aug-15  (Showing All) 15 Hank Sorenson
6 /1023 Laptop 15" EDI SmartPad L200-3 Laptop 08-Aug-15 15-Aug-15 lennifer Weiss

8 11025 Laptop 15" EDI SmartPad L200-4X 26-Sep-15 04-Oct-15 Min Seung

9 : 1031 Laptop 17" Saris X-10 Laptop 04-Oct-15 Nick Ortiz

10 |1032 Laptop 17" Saris X-10 Laptop 19-Sep-15 Stanley Geyer

11 : 1033 Laptop 17" Saris X-10 Laptop 24-Sep-15 26-Sep-15 George D'Agosta
12 /11034 Laptop 17" Saris X-10 Laptop 25-Aug-15 27-Aug-15 lay Peralta

20 6100 Projector Omega VisX 1.0 28-Sep-15 01-Oct-15 Win Armitage

21 : 6101 Projector OmegaVisX 1.0 26-Sep-15 27-Sep-15 Michael Earley
22 |6102 Projector Omega VisX 1.0 22-Aug-15 23-Aug-15 Jamila Kyle

23 : 6200 Projector Saris Lux T-80 01-Sep-15 04-Sep-15 Jolie Chaturvedi
24 16301 Projector Saris Lux T-81 Lite 10-Sep-15 Marques Herndon
25 : 6302 Projector Saris Lux T-81 Lite 08-Sep-15 15-Sep-15 Dean Sorenson
31

32

To remove allfilters from your worksheet, click the Filter command on the Data tab.

.:uns g'l Y Clear
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Sort & Filter

Printing in Excel

There may be times when you want to print a workbook to view and share your
data offline. Once you've chosen your page layout settings, it's easy to preview and
print a workbook from Excel using the Print pane.

To access the Print pane:

1. Selectthe File tab. Backstage view will appear.



2. Select Print. The Print pane will appear.
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To print a workbook:

1. Navigate to the Print pane, then select the desired printer.
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2. Enterthe number of copies you want to print.
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3. Select any additional settings if needed (see above interactive).
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4. Click Print.
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Choosing a print area

Before you print an Excel workbook, it's important to decide exactly what information
you want to print. For example, if you have multiple worksheets in your workbook, you
will need to decide if you want to print the entire workbook or only active worksheets.
There may also be times when you want to print only a selection of content from your
workbook.

To print the entire workbook:

1. Navigate to the Print pane.
2. Select Print Entire Workbook from the Print Range drop-down menu.

Settings

j__l Print Active Sheets
Only print the active sheets

Print Active Sheets
Only print the active sheets

Print Entire Workbook
Print the entire workbook I}

— Print Selection
Only print the current selection

Ignore Print Area

3. Click the Print button.



orint
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To print a selection:

In our example, we'll print the records for the top 40 salespeople on the Central
worksheet.

1. Select the cells you want to print.

2. Navigate to the Print pane.

3. Select Print Selection from the Print Range drop-down menu.
Settings

E Print Active Sheets
Only print the active sheets

E Print Entire Workbook
Print the entire workbook

Print Selected Table
Only print the selected table

Ignore Print Area

(4 Mo Scaling

D 10 Print sheets at their actual size




4. A preview of your selection will appear in the Preview pane.

JANUARY FEBRUARY MARCH APRIL
3 511000 5 9,73800 5 &5,B5000 5 3,BE0.00
& 553500 5 E,36500 5 763800 5 3,533.00
5 540,00 5 404600 5 9,632.00 5 7,B03.00
& FA5L00 5 57700 & B,505.00 5 404500
& 410800 S 717200 & 6,96400 S 213200
5 575500 5 5,01800 5 5,14400 5 TOET.00
& JEST.O0 S 1,54400 5 o,07100 S 210000
3 404500 5 5,63200 5 T7,B0G00 5 B,352.00
= SI7EOD 5 TFITO0 5 5,302,000 5 EA3000
& T7S000 S 427500 & 476700 & 6,750.00
3 156800 5 E,92200 5 B, 76500 5 4,653.00
& 141300 & 5,75000 S o,01800 S 5,144.00
3 958000 5 25700 5 521000 5 59.793.00
& 4573.00 5 S05.00 & 3,21500 5 B,517.00
3 E7E5.00 S E,25ED0 S 63600 & TOET.00
& 770300 5 7,23500 5 761800 5 2,410.00
3 703200 5 5,25500 S o MEDD S 5, 105,00
3 5233.00 5 165000 5 3,05200 5 3,779.00
1 2700 % T,90000 5 320400 5 7, 710000
& 1BES.O0 S 490500 S 6,92500 & 3,493.00
& 425700 5 o,50000 5 25700 & B,210.00
& 400500 S E,43000 S TEE2DD S 487600
3 426700 5 9,58000 5 25700 5 B,210.00
& £525.00 5 7430000 5 7,BE200 5 4 E75.00
3 B7ESOD 5 TE2100 5 3,43500 5 B015.00
& 407500 5 1,240000 5 2,243.00 5 4,353.00
1 977000 5 704200 5 3,37300 S 4,353.00
3 536500 5 164500 5 3,52700 5 743000
& 52ZEEO0 5 527600 5 B,03100 5 4 E75.00
3 966500 5 1,12600 5 5,83500 5 261100
& 651600 5 1,112.00 5 251600 5 7, 5655.00
& 305200 5 465300 S 04TADD S B517.00
3 S19.00 5 531900 5 B,ES1D0 5 453300
& 358200 5 2,2E600 5 3,BBE00 5 756500
1 713400 5 7,59500 5 7,13000 5 519,00
& £302.00 5 3I5E00 & ©,243.00 5 4,554.00
& 3527.00 & 557500 S A,0ME00 S B.510.00
3 470700 5 3,39100 5 555600 5 5,210.00
& 538500 5 250000 5 360000 5 3ATTO0
3 BES.00 5 5,97000 5 4,98500 5 75700
& 500 & 0,72100 5 F2500 & 7,235.00
& 2BRIOD S 446200 S 703200 S B,365.00
-] 254500 5 7,18500 5 G5500 5 TOA2.00
& Ti7200 & £5,55400 5 212200 5 A4,ETE00
1 142500 5 B, 73200 5 7,703.00 5 235600
& 5,ERDLOD 5 38500 5 250100 5 3,6000.00

5. Click the Print button to print the selection.
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If you prefer, you can also set the print area in advance so you'll be able to visualize
which cells will be printed as you work in Excel. Simply select the cells you want to
print, click the Page Layout tab, select the Print Area command, then choose Set Print
Area. Keep in mind that if you ever need to print the entire workbook, you'll need to clear
the print area.

Insert Page Layout Farmulas Data Review
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Margins Orientation Size  Print | Breaks Background Print
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Pac [, Set Print Area =
£ —< 1| LClear Print Area
Adjusting content

On occasion, you may need to make small adjustments from the Print pane to fit your
workbook content neatly onto a printed page. The Print pane includes several tools to
help fit and scale your content, including scaling and page margins.

To change page orientation:

Excel offers two page orientation options: landscape and portrait. Landscape orients
the page horizontally, while portrait orients the page vertically. In our example, we'll
set the page orientation to landscape.

1. Navigate to the Print pane.

2. Select the desired orientation from the Page Orientation drop-down menu. In
our example, we'll select Landscape Orientation.

Settings

= Print Selection

Only print the current selecti...

Pages: : to :
—  {Collated

||=|:||E 1.23 1,23 123 ”
D Portrait Orientation -

D Portrait Orientation

D Landscape Crientation %
[4[Y Mo Scaling
[

10 Print sheets at their actual size

Page Setup

3. The new page orientation will be displayed in the Preview pane.



JANUARY FEBRUARY MARCH APRIL MY JUNE
B 5110.00 § 9,73800 S 6,861.00 S 3,5E9.00 S 6,28200 $ B,51E.00
s £835.00 § 538500 S5 7,633.00 S 3,533.00 5 5,65500 5 1,126.00
5 6640.00 5 404600 5 9,632.00 S 7,E03.00 S E,07600 S 5,130.00
& 7,161.00 § 57700 & B,605.00 S 404500 5 ©,63200 S 7,503.00
& 410500 § 7,17200 § 6,964.00 S 212200 % 9,54200 § 5,252.00
s £755.00 § £,01500 5 5,144.00 5 TOET.O0 5 158800 5 §,522.00
s 7EST.00 S 1,50400 5 807000 § 210,00 5 7,75000 S 4275.00
& 4046.00 § 9,63200 S 7,803.00 § B302.00 % 74500 & 9,721.00
& 8J7EOD § 73700 § 6,302.00 S BA30.00 5 7,88200 S 4,576.00
s 775000 § 427500 5 425700 % 6755.00 % 2,01200 5 5,144.00
E 156B.00 5 E,82200 5 B,765.00 % 4653.00 5 847400 % B,517.00
s 1413.00 § 6,758.00 S 9,019.00 $ 5144.00 % B,55000 S 5,731.00
s 555000 § 25700 5 521000 5 25300 5 £,50400 5 1,452.00
5 4573.00 § 50500 5 3,215.00 5 ES17.00 5 523300 5 1,650.00
s E7E5.00 S B,25800 S £35.00 S TOET.O0 5 158800 5 5,522.00
5 7,703.00 5 7,23500 5 7,615.00 5 2AL0.00 5 1,42500 5 5,732.00
5 FO32.00 5 6,255.00 5 8, 21E.00 % 5106500 5 2,BELD0 % 4A62.00
H 5233.00 § 1,65000 & 3,052.00 § 3,773.00 % 2,40500 S 3,555.00
s £27.00 § 750500 5 320400 5 771000 5 715000 5 577.00
s 1,B85.00 5 4,98600 5 692500 5 3483.00 3 2,48800 5 5,11E.00
3 4267.00 § 9,50000 S 257.00 § B210.00 $ 7,75000 § 4,275.00
B 452500 & 543000 S 7,882.00 & 457600 5 BES.00 & £,979.00
s 4257.00 § £,50000 5 257.00 S 521000 5 7,70000 5 4,000.00
s 682500 5 743000 5 7BEZLOD 5 457500 5 1,BE500 5 4,956.00
3 BTEO.00 § 7,62100 S 343500 $ B015.00 $ 5,24800 $ B40.00
H 4075.00 § 1,24000 § 2,243.00 § 43E3.00 5 3,42500 S 5,545.00
5 877.00 5 704200 5 3373.00 5 4383.00 5 3,42500 5 5,545.00
E B3E8.00 = 164500 5 3527.00 % TAIDOD 5 7,BE200 % 4,876.00
& S52BE.00 § 527600 S B,031.00 § 457600 S 1,58500 % 4,995.00
s o665.00 S 112600 5 5,835.00 S 261100 5 410500 5 5531.00
5 6516.00 5 111200 5 251600 5 7,565.00 5 6,25600 5 B,754.00
& 3,052.00 § 4,653.00 S 0A474.00 § B517.00 % 523300 $ 1,650.00

Brewer, Rachel & 619.00 § 531900 § B,E81.00 S 4533.00 % 7,75200 § 3,756.00

To fit content before printing:

If some of your content is being cut off by the printer, you can use scaling to fit your
workbook to the page automatically.

1. Navigate to the Print pane. In our example, we can see in the Preview pane that
our content will be cut off when printed.

JANUARY FEBRUARY MARCH APRIL MAY JUNE
B 511000 § 9,73800 % £,861.00 = 3EEQOD & 620200 § B51E.00
s 223500 S 536500 % TEIL00 S 3533.00 % o,66500 S 1,176.00
H 654000 5 4,04600 5 963200 5 TE03.00 § 607600 5,130.00
s 716100 5 STIO0 5 BE0S.00 5 404500 5 5,63200 5 7,503.00
H 410E.00 5 7,17200 % 686000 5 212200 § 8,59200 S 5252.00
5 575800 § 5,01800 & 514400 % TOET.O0 & 156800 % B522.00
5 TEIT.O0 § 154400 & S07LO0 B210.00 § 7,75000 43275.00
s 404500 5 9,63200 % T OO0 S 5382.00 % TASDD S 972100
5 9TTEO0 § TIIO0 S 630200 BA30.00 § 788200 § 4,576.00
H 7.750.00 5 477500 5 436700 5 £758.00 % £,01800 3 5,144.00
s 156600 5 552200 5 BTS00 5 4553.00 $ 547400 5 8517.00
H 1413.00 5 575800 5 2,012.00 3 514400 § E,55000 5 5,731.00
5 2550000 § 25700 & B,210.00 $ 5,283.00 § 5,504.00 § 1,452.00
5 4573.00 5 B05.00 5 321500 5517.00 % 523300 § 1,550.00
$ E765.00 S 525800 £ £35.00 % 70ET.00 £ 1,56800 5 5222.00
H 7,703.00 5 7,23500 5 7519.00 3 241000 § 142500 5 B,732.00
s TOIZO0 5 525500 5 321500 5 510600 5 2,85000 S 4462.00
H 5233.00 5 1,65000 5 3,052.00 5 377500 § 540500 5 3,585.00
5 &27.00 5 7,508.00 & 320400 % 7710000 & 7,15000 § 577.00
5 1EES00 5 4,90600 5 682500 § 3483.00 % 2,45800 § 511E.00
s 436700 § 9,50000 % 25700 B210.00 § 7,75000 % 4,375.00
s 428600 S 543000 % TEELOD 457500 £ EESO0 5 £,570.00
5 4267.00 5 2,58000 § 257.00 5 B210.00 $ 7,70000 4,000.00
s 532500 5 7,43000 5 TEELOD 5 4575.00 5 1,88500 5 4,556.00
5 ETEDO0 5 762100 3A435.00 5 E015.00 5 524500 5 B40.00
5 407500 & 1,24000 % 2,243.00 % 4383.00 & 3,42500 % 5,545.00
s 8779.00 5 7,04200 & 337300 % 4383.00 % 3,42500 % 5,545.00
s 536200 5 164500 § 3527.00 % 743000 % 7,BE200 S 4,575.00
$ 52EE.00 S 527600 & 503100 % 457500 £ 1,8B5.00 S 4,926.00
H 856500 5 112600 5 253500 5 251100 $ 4,10600 5 5,631.00
s 651600 5 111200 $ 2516.00 5 756500 5 625600 5 5,754.00
H 305200 5 4,653.00 5 SATAOD 3 BSIT.00 5 523300 § 1,550.00
5 61200 5 531800 & B,ELO0 § 4533.00 § 7,75200 § 3,756.00




2. Select the desired option from the Scaling drop-down menu. In our example,

L select Fit All Columns on One Page.
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Keep in mind that worksheets will become more difficult to read as they are scaled
down, so you may not want to use this option when printing a worksheet with a lot of
information. In our example, we'll change the scaling setting back to No Scaling.

To include Print Titles:

If your worksheet uses title headings, it's important to include these headings on each
page of your printed worksheet. It would be difficult to read a printed workbook if the
title headings appeared only on the first page. The Print Titles command allows you to
select specific rows and columns to appear on each page.

1. Click the Page Layout tab on the Ribbon, then select the Print Titles command.

Page Layout Farmulas Data Review
0 5 Dlas 0

Margins Orientation Size  Print  Breaks Background Print
@ = ~  Arear v Titles

Page Setup Fa

2. The Page Setup dialog box will appear. From here, you can
choose rows or columns to repeat on each page. In our example, we'll repeat a

row first.

3. Clickthe Collapse Dialog button next to the Rows to repeat at top: field.
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4. The cursor will become a small selection arrow, and the Page Setup dialog box
will be collapsed. Select the row(s) you want to repeat at the top of each printed
page. In our example, we'll select row 1.




Doyle, Quincy

5. Row 1 will be added to the Rows to repeat at top: field. Click the Collapse

Dialog button again.

Page Setup - Rows to repeat at top

51:51

The Page Setup dialog box will expand. To repeat a column as well, use the
same process shown in steps 4 and 5. In our example, we've selected to repeat

row 1 and column A.

7. Whenyou're satisfied with your selections, click OK.
Page Setup et
Fage Margins  Header/Footer Sheet
Print area: Rz
Print titles
Rows to repeat at top: | 51:81 Fhz
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Print
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| Print... | | Print Preview | | Dptions.. |

| ok %J| Cancel |

8.

In our example, row 1 appears at the top of every page, and column A appears at
the left of every page.



To adjust page breaks:
1. Clickthe Page Break Preview command to change to Page Break view.

| ]
H @ A - | +  100%

Page Break Preview

2. Vertical and horizontal blue dotted lines denote the page breaks. Click and
drag one of these lines to adjust the page break.

Green, Buckminster

Evans, Marcia we?,225.001| " 761900 S

Williams, Claire

Lucas, Basia s 5,233.00 S 1,650.00 Sg._ 4 3,052.00 $ 3,779.00

Day, Salvador

Fleming, Aaron 5 1,885.00 S 4995.00 S 6,925.00 5 3,493.00

Ross, May

Hogan, Kalia 4 4,996.00 5 8,430.00 % 7,882.00 % 4,876.00

Clemons, Amela

Huff, Amy $ 6,925.00 S 7,/430.00 5 7,882.00 | 3,875.00

Doyle, Lani

Molina, Zeus S 4,075.00 S 1,240.00 S 2,243.00 S 4,383.00

Guthrie, Mona

Ellis, Breanna 5 8,360.00 S 1,645.00 5 3,527.00 5 7,430.00

Hernandez, Vivien

Murphy, Haviva
Lowe, Morgan

Parrish, Urielle
Brewer, Rachel

Larsen, Alden 5 3,582.00 S 2,286.00 S 3,898.00 5 7,565.00

3. Inourexample, we've set the horizontal page break between rows 21 and 22.



Buckminster

|

s 3,582.00 S 2,286.00 5 3,898.00 5 7,565.00

4. Inour example, all of the pages now show the same number of rows due to the
change in the page break.

LY AUGLST SEPTEMEER DCTOBER NOVEMEER DECEMEER
3 426700 5 SE000 5 FEIE B2000 3 775000 5 4275.00
3 438600 5 EA3O00 5 78200 5 48600 5 BBS.O0 5 GETRO0
5 476700 § 25000 % o § B2O00 770000 % 4000.00
5 692500 3 743000 5 TEE2O0 5 48600 3 LEES.O0 5 4506.00
$ B7B200 § TERL00 § 343500 § BOIS00 § 524800 % 40,00
5 77300 5 704200 5 225300 5 877800 3 T2 5 337300
$ a77e00 § 7200 § 33800 $ 43B00 $ 347500 § 5545.00
$ 700 § E21000 5 7,75000 5 E30000 3 35800 § 2843.00
13 Eo00 5 531900 5 EES100 § 420600 5 EA3000 5 TEELOD
3 2,68200 5 TE0I0D 5 EOPEO0 S 13E00 5 B53500 5 &77.00
5 651600 § 111200 § 25600 § 75600 § 625600 3 78400
5 305200 3 AEE3I00 5 00 35 BS7.00 3 523300 L550.00
$ 9730900 § EEELO0 5 388000 5 35700 5 557500 % 4046.00
5 404500 5 SEL00 5 TEBO0 5 454800 3 61500 3 5318.00
5 7.88200 § AFETE00 § LEASO0 S 600§ 621000 $ 598400
$ 630200 35 35R00 % 22300 5 486400 3 2ITRO0 5 7300
13 352700 5 557500 5 409600 5 BESI000 35 E3E00 5 1,545.00
3 224300 5 426400 5 277RO0 5 35700 % 557500 5 4045.00
5 73500 § 761200 § 24000 § e § 621000 598100
$ 240500 3§ 3,58RO00 § L3200 § 14300 § 675800 5 2018.00

To modify margins in the Preview pane:

A margin is the space between your content and the edge of the page. Sometimes you
may need to adjust the margins to make your data fit more comfortably. You can modify
page margins from the Print pane.



1. Navigate to the Print pane.

2. Select the desired margin size from the Page Margins drop-down menu. In our
example, we'll select Narrow.

Settings
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Header: 0.3" Footer: 0.3"
Wide
Top: 1" Bottorn: 1"
Left: 1" Right: 1"
Header: 0.5" Footer: 0.5"

Custormn Margins...
L [ ]

3. The new page margins will be displayed in the Preview pane.
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You can adjust the margins manually by clicking the Show Margins button in the lower-
right corner, then dragging the margin markers in the Preview pane.

Show Margins
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